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1 Application/intended use
e Inductive measurement of specific conductivity and concentration of fluid media in the range of
0...999 mS/cm
e Forusein hygienic applications of the food, beverage and pharmaceutical industries
e Not suitable for use in explosive atmospheres
e Not suitable for safety-related unit parts (SIL)

2 Conformity with standards

The basic safety and health requirements are met through fulfillment of:
e 2014/30/EU Electromagnetic Compatibility

e 1935/2004/EU Consumer Goods Ordinance

e Directive (EU) 10/2011 (Articles in Contact with Food)

e EN 61000-6-2:2005 (Interference Immunity)

e EN 61000-6-4:2007 + A1:2011 (Interference Emissions)

3 Safety instructions

These safety instructions must be followed to

e Avoid endangering persons and the environment.
e  Avoid damage to the sensors.
e  Prevent faulty batches during production.

The electrical connections may only be performed by persons with the necessary technical skills (e.g. certified
electricians or persons with technical training in electrics) and by persons with the necessary authorization from

the operator.

The power supply and the control circuit inputs and outputs must be professionally wired. The current state-of-the-
art of electrical connections must be adhered to. See also section 8 "Wiring diagram".

The following details must be noted in particular:

e Safety instructions
e Electrical connection data

1. All persons involved with the setup, commissioning, operation, service and maintenance of the sensor must
be suitably qualified.

2. This operating manual must be followed closely. The operator must ensure that the personnel has read and
fully understood the operating manual.

3. All work must be performed with utmost care and may only be executed by authorized and trained person-
nel. The applicable national regulations regarding opening and repairing of devices must be complied with.

4. We recommend storing the operating manual in the vicinity of the measuring device in an easily accessible
location.

5.  The sensor must be de-energized prior to alterations and maintenance.
6.  The working area of the operator must offer enough space to minimize the risk of injury.

7. Thetechnical data specified in the operating manual and on the type label must be noted.

Warranty coverage shall not be granted for any damage that can be attributed to improper execution of work on
the device.
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4 Special features/advantages
e Wear-free, inductive measurement procedure

e In contrast to conductive measurement procedures, there are no problems due to electrode deterioration
or polarization.

e  Hygienic design with Negele weld-in sleeve
e Individual setting/programming via PC or Simple User Interface
e  Two configurable LEDs on the display unit

5 Options/accessories
e Simple User Interface with small display (retrofittable)
e Programming adapter MPI-200 (PC-based)
e Tool for detaching the signal module
e Preassembled PVC cables

PVC cable with M12 coupling of stainless steel 1.4305, IP 69k, unshielded

o  Ma12-PVC/4-5m PVC cable, 4-pin, 5 min length
o  Ma12-PVC/4-120m PVC cable, 4-pin, 20 min length
o M12-PVC/4-25m PVC cable, 4-pin, 25 m in length

PVC cable with M12 coupling of nickel-plated brass, IP 67, shielded

o Ma12-PVC/4G-5 m PVC cable, 4-pin, 5 min length

o M12-PV(C/4G-10m PVC cable, 4-pin, 10 min length

o  M12-PV(C/4G—25m PVC cable, 4-pin, 25 m in length
6 Installation and connection

e  The device must be installed such that the submersible body is fully surrounded by the medium and
no air bubbles can form in the sensor area. It therefore is advisable to install the device in rising
pipes.

e  The device must be aligned such that the lettering "FLOW" is at the bottom of the device in the di-
rection of flow.

e  Very strong vibrations can lead to false measurements (e.qg. if installed near a pump).

e  Usethe Negele CLEANadapt system to ensure that the measuring point functions properly.

e  Wheninstalling the device, adhere to the maximum tightening torque of 20 Nm.

e To correctly install CLEANadapt weld-in sleeves, use a suitable welding mandrel. Follow the weld-
in and installation instructions in the CLEANadapt product information.

The ILM-4 inductive conductivity sensor is set to operate without requiring special adaptations. In isolated in-
stances, some parameters may need to be adjusted. The parameterization may be changed using the PC-based
MPI-200 programming adapter or the Simple User Interface directly on the sensor. This can be performed either
directly on location or in the office in a dry simulation.

When setting the parameters, please note that a hierarchy of authorization levels exists (0 Monitoring, 1 Ad-
justment, 2 Setup 3 Calibration and 4 Factory). It is not possible to change the ILM-4 sensor parameters in the
lowest "Monitoring" level. The parameters can be set/adjusted beginning with the "Adjustment" level. The
farther up you move in the hierarchy, the more parameters can be changed at the customer site, although it
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should be noted that the upper levels, "Calibration" and "Factory", are password-protected and access is only
possible on request.

Setting can be made regarding the sensor signal output (4...20 mA signal) and the measurement of conductivity,
concentration and temperature. The 2 analog outputs of the sensor for conductivity, concentration and temperature
are freely configurable.

Conductivity: Two different conductivities can be set independently of each other. The upper range limit can be
freely selected. The temperature compensation and damping can also be set by the customer.

Concentration: The concentration can be select from 2 predefined ranges for common CIP media (NaOH or HNO3).
In addition, up to 8 customer-specific support points (each for conductivity and concentration) can be entered. To
define a range, at least 2 points must be entered, and their values must both be > o. Users can enter these support
points in the "Setup" level and higher. The temperature compensation, damping and upper range limit can also be
set.

Temperature: Output of the temperature of the medium measured at the tip of the PEEK part on the sensor. The
temperature unit and response time can be adjusted.

The table below shows the conductivity sensor settings by authorization level:

Parameter

Settings in the "Adjust-
ment" level

Settings in the "Setup"
level

Adjustable range

Conductivity measurement

Conductivity 1

Temperature Compensa-
tion

Temperature Compensa-
tion

Freely adjustable from o...100%/K

Damping 1

Selectable: inactive, 2.5s, 55,105,205

Upper Range Value

Upper Range Value

Freely adjustable from o.5...1000 mS/cm
(in increments of 0.5)

Concentration

Temperature Compensa-
tion

Temperature Compensa-
tion

Freely adjustable from o...100%/K

Damping C

Selectable: inactive, 2.5s, 55,105,205

Media Concentr. Range

Media Concentr. Range

NaOH o...10%, HNO3 0...20% or cus-
tomer-specific points (beginning with
"Setup" level)

Upper Range Value

Upper Range Value

Freely adjustable from 1...100%

(+) Customer-specific
points, concentration

Up to 8 support points for conductivity
and concentration

Conductivity 2
Temperature Compensa- | Temperature Compensa- | Freely adjustable from o...100%/K
tion tion
Damping 2 Selectable: inactive, 2.5, 55,105,205
Upper Range Value Upper Range Value Freely adjustable from o.5...1000 mS/cm
(in increments of 0.5)
Temperature

Unit Temperature

°Cor°F

Response Time

Normal or rapid

Both the PC/MPI-200 and Simple User Interface software is based on a tree structure.

In addition to the advanced options in the Conductivity Measurement branch, the "Setup" level also enables access
to the Signaling Interface branch. The following parameters for the sensor output signals can be changed in this
branch:

e Signal selection for the 4...20 mA signal: Selection between conductivity 1 or 2, concentration and tem-
perature

e Set value for 4 or 20 mA signal: By default, the lower range limit is used for the 4 mA signal and the upper
range limit for the 20 mA signal. This can be adjusted as necessary.

¢ "No Media" warning signal: Current loop signal when the sensor is not immersed in a medium = dry run-
ning.

e "Outside Spec." warning signal: Current loop signal if an operating state is outside of the specified range.
The measurement accuracy can no longer be guaranteed.
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¢ "Global Failure" error signal: Current loop signal if a malfunction occurs, for example if the device fails.

¢ Signal limit for underrange and overrange: Lower or upper limit of the current loop signal that is still valid

and linear when output below 4 mA or above 20 mA.

¢ "Underflow/overflow" error signal: Current loop signal is below or above the underrange or overrange limit.
¢ Signaling Simulation: Simulates the current loop signal, where the source value is briefly replaced by the en-

tered parameter value.
e LED configuration: These two LEDs can be configured as required. The procedure is described in section 6.3.

A list of the parameters set in the conductivity sensor is included with the delivery. These parameter values, as
well as those changed by the users themselves, can be printed out using the MPI-200 programming adapter via
File > Parameter Data > Print and can also be exported as a file to the PC (via File > Parameter Data = Export

Data File (*.xml)).

When making the settings, note the help texts in the MPI software for each parameter. They provide useful

information on changing the selected parameter.

6.1 Settings using the MPI-200 programming adapter

The MPI-200 programming adapter is connected to the ILM-4 conductivity sensor via the external MPI-200-F
adapter piece. It must be ensured that the ILM-4 conductivity sensor is permanently connected to the supply volt-
age while the parameters are being set.

1: Connection for M12 connector
2: USB port for connecting to a PC

3: Connection cable to adapter for

ILM-4

Measurement

Connected

Connection of the MPI-200 programming

%

(conductivity)

in device

ILM-4 conductivity sensor

Signal
interface

Adapter
MPI-200-F

Connection plug for the MPI-200-F adapter as
an intermediate plug between the ILM-4 elec-
tronics and the MPI-200 connection 3 (see the
next figure).

Negele usB

Tnterface >| MPI-200 =
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After the sensor is connected to the PC and the user software is opened, the following window appears:

. Anderson-Negele-MPL —m
1. Information on the current process value e
2. Buttons for changing the parameter setting e I
3. Information on the current source value e ot pacmmiwsre =1
4. Adjustable PC parameters
5. Adjustable sensor parameters b4 E
Clicking on the.+ in the menu opens a submenu in which param 2 5.
eters can be adjusted.
5. - I~ R
ok e 3

Note:

For further settings, please see also the description in the MPI-200 product information.

To set or change parameters directly in the sensor (see section 6.2 "Settings using the Simple User Interface"),
you need the ID codes contained in the table below. This table only lists the most important ID codes.

Further ID codes can be found in the user software. To view these, right-click on "Info" by the parameter name. An
info box appears with the respective ID (see graphic below):

S info -

1D 30034

oK.

Because the search number must have 6 digits, an additional digit is always added in front of the five-digit ID
(30034 in the graphic above). This digit depends on the node as follows:

4 for changes to the display

3 for changes to the signal interface

o for changes to the conductivity measurement

Because the signal selection is located in the single interface node, the ID code for the "Signal selection" example
above is: 330034.

A list of all ID codes can be printed out via the PC user interface. To do so, click on File > Parameter Data - Print
to open the corresponding window and print out the complete list of ID codes.

List of important ID codes:

IAccess/setup mode
(must be set

Parameter/ before the Search num- Node/ Value name
parameter name change is made) ber (ID num- module
ber)
Display
Contrast User Interface 2 Setup 451020 4 Display (#)
Backlight 2 Setup 451030 4 Display (#)
Screensaver delay time 2 Setup 451050 4 Display (#)

Signaling interface
Current Loop Signal

Signal Selection 2 Setup 330031 3 Signal Int X45a current loop signal
4-mA Setpoint 2 Setup 330111 3 Signal Int X45a current loop signal
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20-mA Setpoint 2 Setup 330191 3 Signal Int Xg5a current loop signal
Underrange Limit 2 Setup 330141 3 Signal Int Xg5a current loop signal
Overrange Limit 2 Setup 330211 3 Signal Int X45a current loop signal
LED 1 digital output

Signal Selection 2 Setup 330034 3 Signal Int LED 1 digital output
Warn-S: no Media 2 Setup 331191 3 Signal Int LED 1 digital output
Warn-S: Outside Spec. 2 Setup 331201 3 Signal Int LED 1 digital output
Fehler-S: Global Failure 2 Setup 331231 3 Signal Int LED 1 digital output
Signal-Auswahl 2 Setup 330035 3 Signal Int LED 2 digital output
LED 2 Digital Output

Signal Selection 2 Setup 330035 3 Signal Int LED 2 digital output
Warn-S: no Media 2 Setup 331192 3 Signal Int LED 2 digital output
Warn-S: Outside Spec. 2 Setup 331202 3 Signal Int LED 2 digital output
Fehler-S: Global Failure 2 Setup 331232 3 Signal Int LED 2 digital output
Conductivity Measurement

Unit of Temperature Comp 2 Setup 013021 0 Measure (#)

Conductivity 1

Temp. Compensation 1 2 Setup 013031 o Measure Conductivity 1
Damping 1 2 Setup 013041 o Measure Conductivity 1
Upper Range Value 1 2 Setup 013091 o Measure Conductivity 1
Concentration

Temp. Compensation C 2 Setup 013032 0 Measure Concentration C
Damping C 2 Setup 013042 0 Measure Concentration C
Media Concentr. Range 2 Setup 013061 0 Measure Concentration C
Upper Range Value C 2 Setup 013092 o Measure Concentration C
Conductivity 2

Temp. Compensation 2 2 Setup 013033 o Measure Conductivity 2
Damping 2 2 Setup 013043 o Measure Conductivity 2
Upper Range Value 2 2 Setup 013093 o0 Measure Conductivity 2
Temperature

Unit Temperature 2 Setup 013144 o0 Measure Temperature
Response Time 2 Setup 013145 o Measure Temperature

6.2 Settings using the Simple User Interface

The software structure of the Simple User Interface is similar to that of the PC version.

The system is operated using two control buttons to the left and right of the display. These two buttons can be
used to navigate through the tree structure of the Simple User Interface to change parameters. The button func-

tions are as follows:

Press and hold

Edit a node, parameter

Jump back to previous node, parameter

Leave editing mode without saving, return to next higher level

Press both buttons for 10 seconds: the menu jumps back to
the beginning (attention: this is not a reset)

Button Press briefly
R Jump to next node, parameter
L
R/L Scroll up and down
Rand L
together
Rright

L left
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Note:

The digits 1), 2) and 3) shown in the graphic below refer to the programming example below.

1)  Briefly press the right button.

2) Press and hold the right button, select the required mode (e.g. Setup) and node (e.g. Signalint), scroll through
the menu using the right/left buttons and confirm the selection by pressing and holding the right button.

3) Pressand hold the right button and then enter the ID number from right to left. Proceed as follows:

a.) Select the desired position (navigation with the right/left buttons, press the left button: Change the

position to the left, press the right button, change the position to the right).

b.) At the desired position, press and hold the right button until the field becomes gray. Then enter the
numerical value using the right/left buttons and confirm by pressing and holding the right button until
the gray area disappears. Then enter the next digit.

c.) Afterall digits have been entered, move all the way to the left with the left button until the field become
gray.
Then press and hold the right button. The system jumps to the selected parameter, which can now be
entered or changed in the same manner. Start by pressing and holding the right button.

For some system-related parameters, you are asked to confirm that you really wish to make the change.
Do this by pressing the left or right button.

Press the right button to change the parameter or save the change.

Press the left button to leave the setting without making a change.

Menu flowchart to change a parameter

Language

(2

(2)

Example of screen display:

Node (19)

Language

English

Node (19)

Language

German

Setup mode Parameter
Select (1) s search
(2) (ID search)
(3)
Node (19)
Shows current meas- Display
urement values.
Access Setting not possible D search
o Monitor No
Node (29)
Signal int.
Setting of com-
monly used
Access parameters ID search
1 Adjust No
Node (19)
Menu for advanced Measure
parameter setup
Access ID search
2 Setup No
Node (29)
Factory setting for
calibration (password-
Access protected)
3 Calibr.
Node (19)
Access to all possible
parametersincl. calibration
d-protected
Access (password-protected)
4 System

(2)

Select
node/module

- Display
- Signal int.
- Measurement
All display and LED
parameters
Node
4 Display
All parameters of
the signal interface
Node (current output)
3 Signal int.
All parameters for
actual sensor (conduc-
tivity, temperature
Node and concentration)
o Measure
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6.2.1

Screen display

After the sensor parameters have been adapted/changed, or after the sensor is switched on and no change is
made, the sensor switches to the display mode after a certain period. In the display mode, all nodes of the conduc-
tivity measurement are run through - conductivity 1, concentration, conductivity 2 and temperature. For each
node, the following values/information is displayed:

6.2.2

The display unit features 2 LEDs that can be individually configured. These can be used to visually indicate
faults directly on-site. The LED to the left of the display is LED 1 while the one to the right is LED 2.

Measured value currently
being output at the cur-
rent output

Parameter/parameter
name

Node/module

Value name

Value currently set for this parameter

LED configuration

The following options can be selected when setting the LEDs:

Signal Selection: The following signals can be selected: conductivity 1 and 2, temperature and concen-

tration.

Output function, direction of action, switch point entry method, switch point, hysteresis
Switch ON Delay, Switch OFF Delay: The digital output is switched on or off with the delay set here.

Values can be set between o...30's.

Warn-S: no Media, Warn-S: Outside Spec., Err-Sig: Underflow, Err-Sig: Overflow, Err-Sig: Global

Failure: The effect of each parameter on the LED display can be set. The following can be selected: "No
Effect on Output”, Output Fast Blinking" (0.4 s interval), "Output Slowly Blinking" (1 s interval), "Output

ON" (LED on continuously) and "Output OFF". "Output" refers to the LED here.
Signaling Simulation: The source value is briefly replaced by the entered parameter value. The following

situations can be simulated: "Output OFF", "Output ON", "Output Slowly Blinking" and "Output flashes

rapidly". "Output" refers to the LED here.

The conductivity sensor is delivered with the following factory settings for the LEDs:

LED 1 (left LED)

Err-Sig: Overflow: The LED flashes every second if the sensor registers an overrange error. If the

sensor is in a normal state, this LED is off.
LED 2 (right LED)

Power ON Signal — Err-Sig: Global Failure: LED lights up continuously in normal mode as long as the
device is supplied with power. If a device failure occurs, this LED flashes rapidly (approx. 0.4 s interval)
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6.3 Examples for settings sensors

This section contains some examples that illustrate how the sensor can be set via the PC user interface or the Sim-
ple User Interface:

6.3.1  Setting of customer-specific concentration curve via PC software:

After the PC software is started, a customer-specific curve for the concentration can be entered via the following
node: Conductivity Measurement = Concentration C = (+). Values need to be entered for at least 2 X and Y points.
Up to 8 support points for X and the associated Y values can be entered to establish the relationship between con-
ductivity (X) and concentration (Y). The Y values together with the associated X values form coordinates that act as
support points for the linearization curve. If o is entered for any of these points, that support point is deactivated.

X-Point o01...X-Point 08 (Conductivity): This parameter is used to define the customer-specific measurement
range of the conductivity. Values can be entered from o...1000 mS/cm.

Y-Point o1...Y-Point 08 (Concentration): This parameter is used to define the customer-specific measurement
range of the concentration. Values can be entered from o...100%.
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6.3.2 Example for setting measurement range 1

Node (19)

Set Access

Language
English

Node (19)

Access
0 Monitor

Rla.

Node (19)

Access

R
y

Node (19)

Access

Rla.

Node (19)

Enter search
number (ID)

Access R
1 Adjust

Change
parameter

Measure
Conducty 1

ID-Search
No

R la.

A 4

ID-Search
000000

Rla.

ID-Search
00000

R/L

ID-Search
00000

R la.

A 4

ID-Search
000001

L

Repeat the

last step
forall
digits

Rla.

ID-Search
013091

L

ID-Search Rla.

A 4

0mS/cm

200,0mS/cm

Rla

Measure
Conducty 1
0mS/cm

R

y
Input of
conductivity
with
L/R

Rla

Save Data?

No / Yes

R

A\ 4
Node (19)

Language
English
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6.3.3 Example for setting temperature coefficient 1

Set Access Enter serach Change
number (ID) parameter
Node (19) Node (19) Measure
R Conduty
> 0mS/cm
Language Access ID-Search
English 0 Monitor No 0.0 %/K
R la. R la. Rla
A\ 4
Node (19) Measure
Conduty
0mS/cm
Access ID-Search
000000
R Rla. R
A 4 A 4 A 4
Node (19) Measure
Conduty
0mS/cm
Access ID-Search
00000 000.0
R la. R/L Rla
\ 4
Node (19) Input of
requested
value
Access R ID-Search with L/R
1 Adjust 00000
Rla. R/L
A 4 \ 4
Measure
Conduty
0mS/cm
ID-Search
000001
Rla. Rlz
A 4
Repeat the
last step Save Data?
forall
digits No / Yes
R la. R
\ 4
Measure
Conduty
0 mS/cm
ID-Search
013031 003.0
L
y
ID-Search Rla.
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7 Dimensions

For all process connections, the conductivity sensor can be ordered with a submersion length of L2o
(20 mm) or L50 (50 mm).

D64

! %
I
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D "
Jf:[ G1 @
. U
@25

@25

®64

81

L 20
27

L20

&

!

81

72

D64

L 50

P25




ILM-4 Operating Manual 15

8 Wiring diagram
2 x M12 plug connection 1 x M12 plug connection
ML2 M12 connector
connector, top (5-polig)
(4-pin) i~
1: Output 1 + A 5 1 Power supply +24 VDC
2 Output 2 + 2 Output + 4 3
3 Output 2 - 3 Output - 5
4 Output 1 - ! 2 4 Power supply - 1 5
5 Digital input E1
M12
connector,

bottom (5-pin)
: Power supply +24 VDC

Not assigned 4 3
Not assigned 5
1 2

Power supply -

AN BN KSR S

Digital input E1

Electrical connection with cable gland

[ oolll\\l
 (@deopee )

1 23 45 6 7 /

GND Steuer- Ausgang 1 Ausgang 2
| eingang

+2?V» . +i; ¢l2'

[ | [

+ - ov | [+ =T + -

24VDC 4-20mA | 4-20mA
— | =

AC DA
AE SPS/PLC

9 Repair and maintenance

The conductivity sensor described here is maintenance-free. However, if it should become necessary to calibrate
the sensor, the offset (zero point) and the span of the sensor can be set in the "Calibration " mode (via the soft-
ware).

For this purpose, navigate to the following window via the user interface (for example, for conductivity 1): "Con-
ductivity Measurement > Conductivity 1 > Offset Conductivity 1" (for offset) or "Conductivity Measurement
-> Conductivity 1 - Slope Conductivity" (for span). For the offset, the set value is added to the calibrated con-
ductivity value set at the factory. For the span, the set factor is multiplied with the calibrated conductivity value set
at the factory. This method can also be applied to concentration, conductivity 2 and temperature (offset only).

The adjustable ranges are:

- Offset conductivity: half of the set measurement range, e.g. -50...50 mS/cm in measurement range
0...200 mS/cm

- Slope Conductivity: 75%...125%.

The setting can also be made via the Simple User Interface directly on the sensor using the ID codes 013071 for the
zero-point conductivity and 013081 for the conductivity slope.

We recommend always using a reference solution and a reference device for calibration.
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10 Technical data

Submersion length

Product-contacting

L20: 20 mm

L5o: 5o mm

Measurement range

The measurement range is freely

adjustable

0...0.5 mS/cm to 0...12000 mS/cm in half-steps

Process connection

Thread

CLEANadapt G1" hygienic
TriClamp 1.5", 2", 2.5", 3"

DN 25 (type F) DN 4o/50 (type N)

Process pressure

Max. 16 bar

Tightening torque

20 Nm (CLEANadapt system)

Materials

Connecting head
Threaded connector
Submersible body

Plastic cover/sight glass

Stainless steel 1.4308
Edelstahl 1.4305, 36 mm
PEEK (FDA approval: 21 CFR 177 2415)

Polycarbonate

Temperature ranges

Ambient
Process

CIP/SIP

-10...70°C
-10...130°C

150°C max. 60 min

Reproducibility

of conductivity

< 1% of measurement value

Resolution/measurement <10 mS/cm 1uS/cm

range 10...200 mS/cm 10 pS/cm
100...999 mS/cm 100 uS/cm

Accuracy Slope + 2% of measurement value
Offset +20 pS/cm

Long-term stability < 0.5% of upper range limit

Accuracy of temperature <100°C Max. 0.5°C

output 100...150°C Max. 1.0 °C

Response time tgo <100 ms

Electrical connection Cable gland 2xM16x1.5

Cable connection
Supply voltage

Protection class

2 x M12 connector 1.4305
18...36 V DC max. 190 mA

IP 69K

Output 2 outputs Freely configurable, conductivity 1 or 2,
temperature or concentration
Weight 8509

Negele Messtechnik GmbH | Raiffeisenweg 7| 87743 Egg an der Guenz | Germany | Phone:

+49(0) 8333.92 04— 0| Fax: +49 (0)8333.92 04 - 49

Anderson Instrument Company Inc. | 156 Auriesville Road | Fultonville, NY 12072 | Phone: 518-922-5315 | Fax: 518-922-8997



